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Welcome to the Hot Potatoes
Setup Wizard

Thiz will inztall Hot Potatoes « 5.5 [5.5.0.13] on waur computer.
[t iz strongly recommended that you cloze all other applications
wou have inning before continuing. T hig will help present any
conflictz during the installation process.

Click Mest to continue, or Cancel to exit Setup.

Setup f Installation Screen

Mewt = Cancel
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E How to install and uninstall Hot Potatoes

Ta install Hot Potatoes, simply unzip the archive into a falder, and run setup.exe. To uninstall, run the
Add/Remove Programs applet in the Windows Control Panel.

~Z Setup - Hot Potatoes

Select Destination Directory
Where should Hat Patatoes be ingtalled?

Select the folder where pou would like Haot Patatoes ta be installed, then clhick Mest.

IE:"uF'rngram Filez'HotPatatoes

‘-ﬁ[ﬁ:'\ Al

E
=

=l c

The program requires at least 17.8 ME of disk zpace.

< Back et > Cancel |
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E Why do | heed to register?

We have included a registration system because we want to have some idea of who is using Hot Potatoes. Ve
would also like to be able to contact all users easily if a bug should appear, or when an update is released. If

you do not wish to be contacted after registration, just check the relevant box when yau fill in the registration
form on the YWWebsite,

Mote that if the programs are not registered, several features are disabled or restricted. Ve appreciate that this
may seem a little annoying, but we do need to give you SOME reason to get in touch!

>+'Hot Potatoes

%

Eile Edit Bookmark Options Help Please enter your user name and registration key.
Contentz|  Index Back Erirt £ B E xit
E User name:l

How to register Kay|

] ] ] [ | am a network administrator registering for all the users of this machine
To register the programs, you can fill in a farm on our Web site at:

W 0K X Cancel &, Geta key

http://'web.uvic.ca’hrd/hotpotiregister.htm

Flease complete the farm fully befare submitting it. YWe will send you back a key which can be used
to unlock all the features of the programs. When you receive the key, simply start one of the

Potatoes (any one will da), then click on the Help menu and choose Register. Then you can enter
your Llser Mame and Key.

Make sure you're entering the exact name and key. The safest way to do it is to copy and paste
from the email message to the registration box. Also, make sure you copy only the name and the
key -- don't include the "User name: " or "Key: " bits.
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The bestway to do this tutorial is to work through it in sequence. However, since you may wish to
find one of these pages again without clicking through the whole presentation, here is a list of the
contents. Starred pages are drag-and-drop exercises, and will require version S+ browsers,

Introduction to Hot Fotatoes

A Multiple-Cholce Quiz made with JEC (Example 1)
A Muliple-Cholce Quiz made with JBC (Example 2
A Gap-Fill Exercise made with JCloze (Example 1)
A Gap-Fill Exercise made with JCloze (Example 2
A Tesdt-Entry Exercise made with JCuiz

A Crossword made with JCross

A Jumbled-Sentence Exercise made with JMix

A Jumbled-Word Exercise made with JMix

An Ordering Exercise made with JMatch

kA MWatching Exercise made with Jhatch

The 2-Minute Challenge: Make wvour first exercise
Easic Steps in Lsing Hot Potatoes

Entering and Saving Data

_onflguring the Qutput

i_reating a \VWeb Page

A Quick Hecap

For further information...
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POTATOES

Half-Baked Software

Introduction to Hot Potatoes

The Hot Potatoes suite s a set of six authoring tools, created by the Research and
Development team at the University of Victoria Humanities Computing and Media Centre.
They enable you to create interactive VWeb-based exercises of six basic types. The exercises
use Javascript for interactivity, and will worlk in Metscape Mavigator and Internet Explorer
wersions 4 and above on both Windows and Macintosh platforms. Two of the tools, Match and
IMix, can also produce drag-and-drop exercises, but these will onby wark with more recent
browsers, because they use the WaC Document Object Model. The authoring tools will also
handle accented characters, 5o you can create exercises in any language based on the Eoman
character set, including French, German, and many other languages. The Windows version will
also allow you to create exercises in any language, using Unicode,

Although the exercises are constructed using JavaScript, you don't need to know anything about
Javascript to use the programs. All you need to do is to enter your data - texts, questions,
answers etc. - and the programs will create the VWeb pages foryou. Then you can post them on
wour Web site. Howewver, the programs are designed so that almost every aspect of the pages
can be customized, so if you do know HTWL or JavaScript, you can make almost any change

tama i ammbk b Fle s s bl A A A s, A, el s km Elm s P e A F H s TR Al - s
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Java=cript to use the programs. Allyou need to dois to enter your data -- texts, gquestions,
answers etc. - and the programs will create the VWeb pages foryou. Then you can post them on
vour Wyeb site. Howewer, the programs are designed so that almost every aspect of the pages
can be customized, so if you do know HTWL or JavaScript, you can make almost any change
woll want to the way the exercises wiorlk or to the format of the VWeb pages.

If you wiorls in a non-profit-making educational institution or context, and you are prepared to
share your exercises by placing them on a publick-accessible Web server, then you may Use
the Hot Potatoes suite free of charge. If you are working for a company or in a commercial
context, or if you password-protect your exercises or distribute them only on an intranet, ol will
nesd to buy a licence (contact Half-Eaked Software for information). However, whether you're
commercial or otherwise, we do ask that you register the programs; all you have to dois to fillin
a form on our VWWebsite, and it helps us to stay in touch with our users and get some idea of who
IS Using our programs. =ee the help file for more information on registration.

Mow Qo on to look at some examples of the kinds of exercises you can make using Hot
Potatoes. (Mote that the data files for all of these exercises are available in the tutorial folder if
yol want to ook at them inside the authoring programs later )
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E What do | need to use Hot Potatoes?

To use the pragrams, you will need:

. Windows 95, 98, 2000 ar NT 4.0 ar abave (A versian of the suite is also available for
the Macintash.)

- A recent version of Netscape Mavigator or MS Internet Explarer

- Access ta a Web server (if you wish to deliver your exercises an the Internet)

If you know HTML and Javazcript, you will be able ta exercise more contral over the final format and
style of your exercise pages, but thiz is not a requirement far creating useful interactive pages with
Hot Potatoes.

To use the exercizes, your students will also need an appropriate brawser. They do NOT need Hot
Potatoes itself.
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E Adding graphics

It 15 possible to type HTML tags directly into most of the Hot Potatoes text boxes, in arder to
insert images or links into the YWeb pages. However, if you want to insert a graphic, you can use
one of the built-in functions to help you. With your cursar in a Hot Potatoes text box, click an the
Insert menu and choose Picture / Picture from Local File. A dialog box will appear, allowing
you to select an image from your hard drive. Then you will see the screen below. From this
screen, you can configure the infarmation which will create the IMG SREC tag and insert it in the
text box. MNote that Hot Potatoes 1= MNOT a WY alWY G Web page editor; the toals on the Insert
menu are only intended to help you create HTML code for the page, and you will not see the
image until you actually compile the page. Also, note that the program automatically creates a
relative file path between your data file (your .jbe, .jel or other Hot Potatoes file) and the image
file an your hard drive. If you dao not intend to put your HTML pages in the same place as your
data file relative to your image files, then you will need to configure the relative path manually to
ensure that the image appears on your page. This will be much easier if you understand basic
HThIL.

Here is the Insert picture screen. Click an the graphic to get more information about how it works.

B HalfBakedLogo.gif =]
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E Adding graphics

B HalfBakedLogo.qgif
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E Adding sound and video

It's increasingly common to add sound and wideo to WWeb pages, and this i1s especially appropriate in the
case of educational matenals. Adding sound or video to your pages 1= basically no different from adding a
link to a file; sound files and wideo files are no different frorm ather files. Here are some basic guidelines,
and a couple of example scenarios.

First, create your media files...

Hot Potatoes does not contain any toals for creating or editing sound or wideo files. For this, you will need
to find other software programs. Most modern sound cards can be used far recording or capturing sound
on digk, but you may need to get some special software with which to edit . “ideo is a little mare
complicated, since you may need a video card which has video capture capabilities, and not all video
cards can do this.

Linking to a simple sound file

Let's imagine that you have a sound file called listen.wav. MYAY files are a common sound file format,
usually created on WyYindows, and used for short sound segments.) The file 1= sitting in the same folder as
your JBC exercize. You would like your students to be able to listen to this file before they answer
Cluestion 1 of your JBC quiz. Here's what you do:

1. Make sure you have saved your JBC exercise.

2. Click in the Cluestion field of Question 1 in JBC.

3. Click on Insert/ Link / Link to Local File.

4. If a message appears, read it and make sure you understand it, then press OK to bring up the Cpen

[ | " 1 1 -
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E Adding sound and video

4. If a message appears, read it and make sure yvou understand it, then press OK to bring up the Open
File dialog box.

5. Find your sound file and select it, then press Open. You will now see the |nsert Link dialog box.
b. In the case of a sound file, you probably should not specify a Target attribute - leave this box blank.
/. Inthe Link Text box, type an appropriate piece of text, such as "Click here to listen to the text”.

8. Press OK.

Mowe, when you compile your Web page, you should see a link in Cluestion 1. Clcking on the link will
play the sound file. Mote that fowthe file is plaved (what application is used to play it) really depends on
the user's browser. Sometimes Gwick Nirme will pop up, sometimes the Windows Wedia Flayer, and
sometimes another application; it all depends on what i= installed on the user's machine, and you have
no control over that. However, somethiing should always appear which can play the file, as long as the
user's computer is able to handle sound.

There are several other types of sound files that vou can use; among other popular types 1s Aealdudio,
which is played by a free plug-in. Aeaidudio files are very compressed, and can be much smaller than
WWAY files. You can encode your own sound files in Aeatdudio format using a free encoder -- see the
Fezidudio Website for mare infarmation:

http://'www.real.com

Linking to a video file

Linking to a wideo file 15 really no different from linking to a sound file. Just follow the steps above, but

B B B T1 B B T I O I T I I B P B B R T e T T P R EI T, o ST



E Adding sound anq video

Hea!ﬂ.ud&o Yiehsite fu:ur frore mfu:nrrnatn:un
http://www.real.com

Linking to a video file

Linking to a video file 15 really na different fraom linking to a sound file. Just follow the steps above, but
select a wideo file instead of a sound file. Howewer, you should note that, in order to view the video, your
user's computer must be able to handle the specific wvideo farmat vou have chosen. It's a good idea to do
extensive testing on various types of machine to make sure that your video 15 in a farmat which the user
can play. If you're using a format such as Realvidea, you might want to include a link on the page =o that
users can download and install the Realvideo plug-in if necessary.



> Hot Potatoes - |E
File Edit Bookmark Options Help

Contentz)  [ndex Back Frint £4 i E xit

E Creating Web pages

When your data is ready, and you have checked the Configuration information, you are ready to create a
YWWeb page. Creating WWeb pages is the simplest part of using Hot Potatoes. |Jse the Create Web Page
commands, accessible through the File menu or the toalbar:

All of the Potatoes use the same command to create a version 5 ar version B export file, which 15 a single
HTML file. ou can post this file on your server, and the exercise will appear when you load it. If you are
using JMix or JMatch, there are other aptions, however. JMatch has two other output types: one is a
flashcard output, which you can use to let your students practice or memorize something before quizzing
them on it, and the other iz a drag-and-drop form of the exercise. JMix also has drag-and-drop formats.
The version 5 output format i1s designed for alder browsers, while the version B formats require mare
recent browsers. This is a basic list of browser requirements:

Mon-drag-and-drop version & exercises:

Windows: Internet Explarer 4.1 and above; Metscape MNavigator version 4.05 and above.
Macintosh: Internet Explarer version 4.5 and above; Netscape Mavigator version 4.08 and above.,

“ersion b exercises:

Windows: Internet Explorer 5.5 and above; Metscape MNavigator version b and above.
Macintosh: Interet Explarer version & and above; Netscape Navigator version 6 and abave,

All version & and & drag-and-drop exercises:

Windows: Internet Explorer 5.5 and above; Metscape MNavigator version b and above.
Macintosh: Internet Explarer version & and above; Netscape Navigator version 6 and abave,
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E Creating Web pages

Choosing an output format

You should choose an output format based on the needs of your users, the type of material, and the kind
of brawser you can expect your users to have. You can ensure broad compatibility with a wide range of
browsers by using the version 5 output farmats. However, these pages are hased on frames, and there
are one or two prablems assaciated with using the brawser's BACK hutton when using frame-based
pages. The version B output pages are mare compliant with emerging Web standards, and are easier to
edit from the paint of view of display because they have built-in C55 stylesheets.

Creating and viewing your pages

When you have selected the type of output you want, and specified a file name, the Weh page will be
created. The pragram will then ask you if you wish to see the exercise in a browser. If you say yes, then
your default brawser program will be launched, and the exercize will be loaded inta it. You can check that
the results match your expectations.

Choosing good filenames

If you enter a file name containing a space, the program will warn you that this is not a good idea; the
reasan for this is that an many VWeb servers, spaces will be replaced with "%20", and therefore the URL
of your document may nat be what you expect it to be. It's best to avaid spaces in the file names of Weh
pages.

Old output formats

If you are upgrading from Hot Potatoes version 4 ar 4.1, yau will notice that the output system has heen
simplified, and DHTML autput items are nat listed on the File menus. This is because we have been ahle
to reproduce all of the functions previously done using DHTML in standard HTML lavaScript. The only

Aowmmetime e e Avad A Al m T Rl TRAAE R A e bae Biamn dmms e s e s
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E Creating Web pages

However, you may want to use the old output farmats for some reason. They are still available. To access
them, all you need to dao is add their buttons to your toolbar. Click on the Options menu, then an Toolbar
Options, put a check next to the Export to HTML and Export to DHTML options in the list, press 0K,
and toolbar buttons for these ald %3 and W4 output formats will appear on the main screen. This is the
difference between the two old output formats:

HTML {V3) output

The HTWL output 15 compatible with browsers from version 3 onwards. It 15 like the output fram the old
version 3 of Hot Fotatoes (except that it's a bit prettier!). This output is based on frames, and even a
simple exercise will probably consist of several files. If you click on the W3 button on the toaolbar, the
program will ask you to specify a file name for your exercize. This will be used as the main file name for
your pages (the frameset file). In the case of a simple exercise, all the programs except JMatch will also
create at least two maore files: a "welcome” file {with a file name based on the main name but ending in
w.htm), and a "code” file {with a file name ending in -c.htm). So, for example, if you make a gap-fill
exercise and choose the file name "gaps.htm", the program will create:

"gaps.htm” (the main file -- link to this an your site)

"gapsw.htm" (the welcome file, shown in the top frame when you first see the
BXEICISE)

"gapsc.htm” (the code file, containing the exercise itself, shown in the bottom frame)

All of these files must be in the same directary or folder on your hard drive ar server before the exercise
well| ek,

DHTML {(V4) output

Thao MIHTRAL madvaat nntian ncac tha Nenarmie HTRAL canahilibias of varcinn A krossecare 1o menvida fastiros
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E Creating Web pages

DHTML (\V4) output

The DHTKL output option uses the Dynamic HTWL capabilities of version 4 browsers to provide features
such as hiding and showing of questions, and drag-and-drop. The DHTMWL output should wark on the
following browser versions:

Netscape 4.084.75 and above on Windows and Macintosh
Internet Explorer 4.01 and above on Windows only.

Mote that these pages will not work on Metscape b, nor on Internet Explorer for the Macintosh. Therefore,
we suggest that you avoid these autput formats unless yvou have good reason to use them.

In the case of simple exercises without reading texts, the DHTML output will consist of a single file.

Mote that the DHTML code used for these exercises is based around some functions written by Dan
Steinman (http://www._dansteinman.com), to whom we are profoundly grateful. His code, known as
the Dynamic Layer AP, is released under GRL public licence, and the Hot Potatoes source files contain
an acknowledgement of the origin of these routines; this acknowledgement should not be removed, since
it i1s a legal requirement of the licence.
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E The hotpotatoes.net hosting service

hany Hot Potatoes users have asked for a system by which they can track students' access to exercises
and retrieve their scores. This can only really be done using a server application, so in collabaration with
Creative Technalogy (Microdesign) Ltd in the LIK, we have created hotpotatoes.net. If you get an account on
the hotpotatoes net senver, you will be able to upload your exercises directly from each Fotato to the server,
and your students can log on to do the exercizes. Their scores will be saved autamatically, and you can
track their access times and perfarmance through the hotpotatoes.net database. The senice is located here:
http://’www.hotpotatoes.net
Tao upload an exercise to hotpotatoes. net, this iz what you need to do:

1. Export the exercize in b format {only vb farmat 1= supported).

2. After expart, you will see a dialog box which gives you the aption of uploading to the server (shown belaw)
Choose the second aption.

=¥ View or upload the exercise _ O]

What would you like to do?

&2 View the exercise in my browser |

X Mothing |
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E The hotpotatoes.net hosting service

7 Help

3. The program will then check for media files and ather links in your exercise, so that it can upload any files
that are necessary. It will also check an the server to see if any of these files are already there; if they are,
yaou will be given the chaice to upload them again, ar not.

4. The program will ask you which class you want to upload the exercize for. On hotpotatoes. net, students
are arganized into classes, and each upload is assigned to a class. If you haven't specified any classes,
you will see a default "Class 1"

5. The program will upload yaur page, tell you the URL, and offer to let you view it.

S > |

Your file is accessible here: hittp: ffus 1. hotpotatoes, netfex 3/ XMRZVWCF. php. The URL has been placed on the dipboard.

You can also upload files which are not exercises to hotpotnet. To do this, use the Masher. The Masher has
a special hotpotnet menu which allows you to upload single WWeb pages {ar other types of file, such as PDF
or WWord documents) to the hotpotnet server.

suppoart for hotpotatoes.net s provided by Creative Technolagy -- see the hotpotatoes. net Website far help
and infarmation. If you are having problems with uploading files to hotpotatoes. net from within Hot Potatoes,
then write to support@halfbakedsoftware.com far help.
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E The File menu

The file menu is basically the same in all the pragrams, although there are minar differences. Click
anywhere an the graphic to get specific infarmation an each item. Mote that JMatch has ane extra File
Menu item, Export to Flashcards; this enables you to create 5 Weh page that functions like flashcards,
for learning/memarizing items prior to quizzing. JMatch and JMix also have drag-and-drop export items.

Hle

2 Mew Cirl+M
= Cpen Cirl+0
H s Ctrl+5
EI Save As

i Add Beading Text Ctri+8
%% Add Metadata Cirl 4+

*+ Append Ble
% Create Web pane » % Welr pape for v3 browsers
I=h Export for Brinting Crrl+P ﬁ Web page for vebrowsers  F&
&R Export For WiebCT
jbci.jbe
Miditerm.jbc
testupload .jbc
may 200 2pretest.jbc
testagi.jbe

¥ Ext Cirl+Q




The Insert menu is the same in all programs. Click an the graphics to get more infarmation on the menu items.

| Insert.
E Picture
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The Manage Grid mem;

The Manage Questions menu is available in two programs, JOuiz and JBC, and a similar Manage ltems
menu is included in JMatch (these are the only programs which include multiple items on one page). These

functions allow you to change the order of questions or tems, by dragging and dropping, moving, inserting or
deleting guestions. Click on the graphic to get more information.

. Delete Question
e |neert Question

= Move Question
7]

-
)

lone Guestion

Bto-Fesponse

[
E Shuffle k ﬂ Order of Questions

:.',.—:' Order of Anzwers
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E The main JQuiz screen

JQuiz is used to create shott-answer quizzes in which the student types in his or her answer, which is
then checked. This is the main screen far the JQuiz program. Click on the graphic to learn mare about
its functions.

5¥ IQuiz: [Untitled] =] E3
Eile Edit [Insert Manage Questions Cptions Help

acHESEY | 2R Xm | EEAER (B | 2

Title The Cat Quiz

Q 1 21 | How many lives does a cat have?

Correct Answers

hine

.
v
1
2
3

5.0
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E Configuring the output

The exercises created by Hot Potatoes programs use a variety of buttons and prompts to inteface with the
user (the student). While the data for exercises (questions, answers etc.) will change from exercise to
exercise, such things as button captions, prompts, and explanations will not change so often. These are
therefore stored in the farm of a configuration file. By default, the six programs share the same configuration
file, so that common items such as the captions of "Check” ar "Hint" buttons need to be changed only
once. Using the configuration screen, you can set up the programs to produce output in any of the
languages supported by the 286-character ASCIH set (which includes any language based on Foman
characters, including the accented characters used by many European languages). See Using Hot Potatoes

in other languages for mare information on fareign language support.

Each program provides an interface to the configuration file, accessible through the Configuration button on
the toolbar, or the Configure output command on the Options Menu. These will bring up a screen like the
one below, giving access to all the configuration data relevant to the application you are using. You can click
on the graphic to get mare information about items and functions.

,i’ Configuration file: C:hDatahDelphistHP5' english5.cfg

Edit  Insert

: TitlesdInstuctions ; F'ru:umpts.-’FeedI:uan:kI Euttnnsl .ﬂ«ppearancel Fleau:lingl CGl I

Exercise subtitle;

Gap-fill exercise

Instructions:
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E Configuring the output

Instructions:

Fill in all the gaps, then press "Checlk! to check your answers. Lse the "Hint" button to get a
free letter if an answer is giving you trouble. You can also click on the *[Y]" hutton to get a
clue. Mate that you will lose paints ifyou ask for hints or clues!

= Load E Save E:I Save s o OK ? Help

Here is another page in the configuration dialog. As above, you can click on the graphic to get maore
information about the items:

,f Configuration file: C:'Datah Delphist HP5 Y english5.cfg
Edit  Insert

TitlezdInstruchions | Prompts/Feedback EUttDﬂS .ﬂ.ppearancel Headingl (NE] I

.......................

Caption for "Check Answer" button: |Check

L Inelnda "Hint" hoittnn E':Flt‘lTinr‘l'IHir‘lT
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E Configuring the output

Edit  Insert

[+ Include "Hint" button

—avigation

Caption for"Check Answer" button; [Check

[+ Include "Go to Contents" button

Captian: Hint
¥ Include "Clue" button for each gap Caption: |[*]
W Include "Mext Exercise" button Caption: |==
Mext exarcise URL: chlnzez.htm C> Browse. . |

Captinn:l'”de}{

Contents page URL: Icnntents.htm

[+ Include "Back" button

(= Browse...

==

isaption:

= Load | H 5ave EE save bs

? Help |




It is possible to send quiz scores through
email, but it is much easier to use the HotPotatoes.net service
to record grades remotely.

¥ Configuration file: C:\WINDOWS
Edt  lmzert

Titles.-"lnstructin:unsl F'rcnmpts;"FeedI:uan:kI Euttunsl ﬁ.ppearancel Fleau:lingl Other LGl |
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End of
Introduction and Tutorial
from the Hot Potatoes Program
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